Starting a Project

Double click Blank Project, select a Recent project, or click Open Other Projects to work on a saved project stored on disk or on SkyDrive.

The Microsoft Project 2013 ‘Start’ screen

To Enter General Project Info

1. Select the File tab.
2. Select Info.
3. Click Project Information at the far right.
5. Enter a Project Title, Company Name, Comments, etc. into the pane at the far right.

TIP: For non-working days that occur on a regular basis (eg. certain Bank Holidays), you can click the Details... button and set a recurrence pattern and range.

Scheduling Tasks with Manual Dates

Manually scheduled tasks have user-defined start and finish dates, i.e. you enter your tasks rather like appointments in a diary. Project will never change their date unless there may be a conflict with another task already entered.

1. Click the first row of the Task Sheet under Task Name.
2. Type the name of your first task; a push pin icon will appear in the Task Mode column to indicate the task is manually scheduled.
3. Click in the Start column for the tasks.
4. Enter a date for the task to start.
5. Enter in the Finish column for the tasks.
6. Enter a finish date for the tasks.
7. Continue entering tasks as described above in subsequent rows of the Task Sheet.

To Enter a Project Start Date

1. Select the File tab.
2. Select Info.
3. Click on the Start Date at the far right.
4. Enter the earliest date that your project can start.

TIP: Ignore the Finish Date field as this will be calculated automatically once you have set up your project tasks.

Setting the Standard Calendar

The project needs to know what of the week/month/year are available to schedule the project tasks into.

1. Select the Project tab.
2. Click the Change Working Time command in the Properties group.
3. Type a description (eg. Spring Bank Holiday) for the nonworking day(s) in the first row of the Name column of the Exceptions tab.
4. Enter the date(s) of the nonworking day(s) in the Start and/or Finish columns.
5. Continue adding non-working days as described above.
6. Click OK when finished.

To Save the Project

1. Select the File tab.
2. Click Save.
3. Type a file name and select a location to store the file.
4. Click Save.

Scheduling Tasks with Relationships (Auto Scheduled)

Linking tasks with relationships is preferable to setting start and finish dates manually. This is because if a task duration changes or another task is inserted or deleted, the remaining tasks are rescheduled automatically.

The most commonly used relationship is the Finish-to-Start. This is used in cases where one task must start as soon as possible when another task finishes.

Terms used with relationships are “predecessor” and “successor.” Predecessor is a task that another task depends on in some way. Successor is a task that depends on another in some way.

Other relationships are:

Start-to-Start – successor starts as soon as predecessor starts.
Finish-to-Finish – successor finishes as soon as predecessor finishes.
Start-to-Finish (rarely used) – successor finishes when predecessor starts.

Entering Auto Scheduled Tasks

1. Select the Task tab on the Ribbon.
2. Click the Mode command in the Tasks group.
3. Select Auto Schedule.
4. Click into the first row of the Task Sheet under Task Name.
5. Type the name of your first tasks.
6. Enter a duration for the task.
7. A bar and arrow icon will appear in the Task Mode column to indicate the task is auto scheduled.

**Tip:** If you have already entered manually scheduled tasks and wish to change them to auto scheduled, select Manually Scheduled from the Task Mode column to the left of the task name.

### Creating Tasks Dependencies

Once you have entered the tasks in your Task Sheet, you can link them into relationships by a variety of techniques. Two methods are given below.

**Toolbar Button:**
1. Select two or more consecutive tasks. If tasks are not consecutive then use the Ctrl key to select successor tasks.
2. Select the Tasks tab.
3. Click the Link Tasks button in the Schedule group.

**Task Information Dialog Box**
1. Double-click the name of the task that you want to make a predecessor of another task.
2. Click the Predecessor tab.
3. Enter either the ID number or the name of the task that you want to make predecessor of this one.
4. Click OK.

To add lag or lead time to a dependency:
1. Double-click the name of the task that you want to add lag or lead time for.
2. Click the Predecessors tab.
3. In the Lag field, type a negative number or percentage for lead time or a positive number or percentage for lag time.
4. Click OK.

**Tip:** You can quickly add lead or lag time to a task by double-clicking the link line on the Gantt Chart, and then typing the amount of lead or lag in the Lag box.

### Modifying Tasks Dependencies

If a dependency needs to be edited:
1. Double-click the name of the task that you want to make changes to.
2. Click the Predecessor tab.
3. Make changes as necessary.
4. Click OK.

If you merely want to change the dependency type, or modify lead or lag time:
1. Double-click the link line between the two tasks on the Gantt Chart.
2. Select a different dependency from the Type: list.
3. Add or remove lead or lag time in the Lag: spin box.

### Applying Constraints and Deadlines

By default, tasks in Project are scheduled As Soon As Possible. Sometimes, however, tasks are subject to Constraints or Deadlines which will affect when they can occur.

To apply a constraint:
1. Double-click the name of the task that you want to apply the constraint date to.
2. Open the Advanced tab.
3. Select the type of constraint required from the Constraint Type: drop-down list.
4. If applicable, enter a constraint date in the Constraint date: box.
5. Click OK.

**Tip:** A Start No Earlier Than constraint can also be created by typing a date directly into the Start column of the Task Sheet.

A Deadline can be applied to a task using the Task Information dialog box (see above). A deadline appears as a small green arrow on the Gantt Chart to the side of a task bar.

If changes are made to the project tasks which result in a deadline not being met, an indicator will appear in the left column of the Task table.

1. Double-click the name of the task that you want to apply a deadline date to.
2. Open the Advanced tab.
3. Type or select a date in the Deadline box.
4. Click OK.

### Editing Tasks and Durations

**Inserting and Deleting Tasks**

**To insert a task:**
1. Click anywhere along the row where you want to insert the new one.
2. Select the Task tab.
3. Click the top half of the Task command in the Insert group.

**To delete a task:**
1. Select the Task Name and press the Delete key on the keyboard.
2. Select Delete the task from the option button which appears at the left of the cell.
To outline the tasks into summaries:
1. Select the tasks that you want to group into a summary phase or section.
2. Select the Task tab.
3. Click the Insert Summary Task command (Insert) group.
4. Type a name for the summary phase or section.
Or
1. Insert a new task immediately above the tasks that you want to group into a summary.
2. Give the new task a suitably descriptive name (eg. Phase 1; Planning Section, Product Development).
3. Select the tasks below the summary (sub tasks) that you want to make part of it.
4. Select the Task tab.
5. Click the Indent Task command in the Schedule group. This moves the task(s) to a lower level in the hierarchy and creates the Summary Task from the one immediately above the selection.
Tasks can be indented further, if required, to create summaries within summaries.

Click the Outdent Task button to move tasks to a higher level in the hierarchy.

NB: Project automatically calculates summary task data, such as duration and cost, from the subtasks. Because most of it cannot be edited, you must update the individual subtasks if you need to change a summary task’s values.

Creating a Project Outline
Tasks can be organised into a hierarchy or Work Breakdown Structure (WBS) in order to summarise phases of work. This will add organisation and clarity to the project and assist in its reporting. Outlining is carried out by “indenting” tasks that share common characteristics or timeframe, under a “Summary Task.”

Creating Outlining or Moving Tasks

1. Click the row number (ID) for the task that you want to copy or move.
2. To move the task(s), click Cut in the Clipboard group.
3. To copy the task(s), click Copy in the Clipboard group.
4. Select the ID of the row where you want to paste the task(s).
5. Click Paste. If there is information in the destination row, the new row(s) will be inserted above it.

Tip: You can insert or move a task by right clicking a task ID number and selecting Insert Task or Delete Task.

Copying or Moving Tasks

1. Click the row number (ID) for the task that you want to copy or move.
2. To move the task(s), click Cut in the Clipboard group.
3. To copy the task(s), click Copy in the Clipboard group.
4. Select the ID of the row where you want to paste the task(s).
5. Click Paste. If there is information in the destination row, the new row(s) will be inserted above it.

Tip: You can also insert or move a task by selecting the entire row, holding the mouse pointer over the task ID number and then clicking and dragging it to a new position in the task list.

Tip: To prevent Project from automatically re-establishing task dependencies when tasks are copied, moved or inserted, click the File tab > Options > Schedule > Scheduling options for this project and uncheck AutoLink inserted or moved tasks.

Outlining a Project

Outlining in Project is done automatically, under the “Summary Task.”

Tip: When you copy, move or insert a task, Project tries to re-establish task relationships and it may not always do so in the manner expected.

Tip: To prevent Project from automatically re-establishing task dependencies when tasks are copied, moved or inserted, click the File tab > Options > Schedule. Scroll down the panel to Scheduling options for this project and uncheck AutoLink inserted or moved tasks.

Copying or Moving Tasks

1. Click the row number (ID) for the task that you want to copy or move.
2. To move the task(s), click Cut in the Clipboard group.
3. To copy the task(s), click Copy in the Clipboard group.
4. Select the ID of the row where you want to paste the task(s).
5. Click Paste. If there is information in the destination row, the new row(s) will be inserted above it.

Tip: You can also insert or move a task by selecting the entire row, holding the mouse pointer over the task ID number and then clicking and dragging it to a new position in the task list.

Tip: Although you can copy or move a task at any time, it’s best to do so before you establish task dependencies. When you copy, move or insert a task, Project tries to re-establish task relationships and it may not always do so in the manner expected.

Tip: To prevent Project from automatically re-establishing task dependencies when tasks are copied, moved or inserted, click the File tab > Options > Schedule. Scroll down the panel to Scheduling options for this project and uncheck AutoLink inserted or moved tasks.

Outlining a Project

Creating a Project Outline

Tasks can be organised into a hierarchy or Work Breakdown Structure (WBS) in order to summarise phases of work. This will add organisation and clarity to the project and assist in its reporting. Outlining is carried out by “indenting” tasks that share common characteristics or timeframe, under a “Summary Task.”

Outlining in Project is done automatically, under the “Summary Task.”

Tip: When you copy, move or insert a task, Project tries to re-establish task relationships and it may not always do so in the manner expected.

Tip: To prevent Project from automatically re-establishing task dependencies when tasks are copied, moved or inserted, click the File tab > Options > Schedule. Scroll down the panel to Scheduling options for this project and uncheck AutoLink inserted or moved tasks.

Outlining a Project

Creating a Project Outline

Tasks can be organised into a hierarchy or Work Breakdown Structure (WBS) in order to summarise phases of work. This will add organisation and clarity to the project and assist in its reporting. Outlining is carried out by “indenting” tasks that share common characteristics or timeframe, under a “Summary Task.”

Creating a Project Outline

Tasks can be organised into a hierarchy or Work Breakdown Structure (WBS) in order to summarise phases of work. This will add organisation and clarity to the project and assist in its reporting. Outlining is carried out by “indenting” tasks that share common characteristics or timeframe, under a “Summary Task.”

Creating a Project Outline

Tasks can be organised into a hierarchy or Work Breakdown Structure (WBS) in order to summarise phases of work. This will add organisation and clarity to the project and assist in its reporting. Outlining is carried out by “indenting” tasks that share common characteristics or timeframe, under a “Summary Task.”

Creating a Project Outline

Tasks can be organised into a hierarchy or Work Breakdown Structure (WBS) in order to summarise phases of work. This will add organisation and clarity to the project and assist in its reporting. Outlining is carried out by “indenting” tasks that share common characteristics or timeframe, under a “Summary Task.”

Creating a Project Outline

Tasks can be organised into a hierarchy or Work Breakdown Structure (WBS) in order to summarise phases of work. This will add organisation and clarity to the project and assist in its reporting. Outlining is carried out by “indenting” tasks that share common characteristics or timeframe, under a “Summary Task.”

Creating a Project Outline

Tasks can be organised into a hierarchy or Work Breakdown Structure (WBS) in order to summarise phases of work. This will add organisation and clarity to the project and assist in its reporting. Outlining is carried out by “indenting” tasks that share common characteristics or timeframe, under a “Summary Task.”
8. Enter the availability of the resource in the Max. Units column. Project uses this figure to determine the maximum amount of work that a resource can do in a day. It will then give you a warning if you plan too much work for (over-allocate) a resource.

In the case of individual resources (Tom, Kate, Jo), it is advisable to keep this figure at 100%. In the case of groups of resources (eg. Consultant, IT Team, Typist), multiply the number of resources by 100. For example if you have a group of 6 consultants working on the project, enter a Max. Unit of 600%. Project will then calculate that the Consultant resource can do 6 x 8 hours work/day (48hrs).

Max. Units are not entered for Material or Cost resources. Project assumes an infinite supply of these.

Entries into other columns of the Resource Sheet will be covered later in this guide.

### Assigning Resources to Tasks

This can be done in a variety of ways. The **Task Information Dialog Box** method is given below because it offers the most control over how the data is entered.

1. View the Gantt Chart.
2. Double-click the name of the task that you want to assign resources to.
3. Select the **Resources** tab.
4. Click into the first row of the **Resource Name** column.
5. Click the drop-down list.
6. Select the name of the resource.
7. Click into the **Units** column.
8. Enter as a percentage, the number of units of this resource that you want to assign to the task. Project uses this figure to calculate how much effort (man-hours) the resource needs to work on the task. For example, if you assign 100% units of Tom to a task, Project will calculate that Tom is required to work on the task 100% of his time. If, therefore, Tom works an 8hr day and Tom is assigned to a 5-day task, Project will calculate that Tom needs to perform 5 x 8 hours (40 man-hours) work on the task.

9. If necessary, repeat steps 4 - 7 above in other rows of the Resource Name/Units columns, to assign more resources to the task.
10. Click **OK** when finished.

### Modifying Resource Assignments

Once you have assigned resources to tasks, you may have to make changes. The **Task Information Dialog Box** method is given below because it offers the most control over how the data is edited.

1. Double-click the name of the task that you want to modify the resources.
2. Select the **Resources** tab.
3. Add additional resources and their respective units to the next available row in the table.
4. Remove existing resources by clicking onto the name of the resource that you want to remove and pressing **Delete** on the keyboard.
5. Replace existing resources and units by clicking into the appropriate cell of the table and typing, selecting from the drop-down list or clicking the spin button.
6. Click **OK** when finished.

### Scheduling Resource Assignments

When you change the resource units assigned to a task, Project 2013 keeps the duration constant and increases or decreases the amount of work being done on the task.

In some cases, you may prefer for the duration to be increased or decreased. After all, it could be argued that two people will do the job of one in half the time! This can be achieved in a couple of ways:

#### Method A - Override with a manual change

If you make a change to the assigned units for a task and Project does not re-calculate the duration, simply click into the duration column for the task that has been affected and type the duration to whatever you wish it to be.

1. Double-click the task for which you want to change the task type.
2. Click the **Advanced** tab.
3. Click to place a tick mark in the **Effort driven** check box.
4. Click **OK**.

**Tip:** To make all your tasks Effort Driven BEFORE you enter them, click the **File** tab > **Options**. Click **Schedule** and tick the **New tasks are effort driven** box under Scheduling options for this project.

For further information and explanation of this and other scheduling issues, search for “About effort-driven scheduling” in Microsoft Project Help.

### Identifying Resource Overallocations

Overallocation occurs when you assign more work to a resource than he/she/it can do in one day.

Project 2013 warns you of an overallocation by:

- Placing a red figure at the left of the task(s) affected.
- Highlighting affected resources in a red font on the Resource Sheet.

You can use the **Team Planner** to investigate in more detail why, where and when the overallocation(s) occur.

1. Select the **View** or **Resource** tab.
2. Click the **Team Planner** command.
3. Observe the overallocated resources (they will be in red).

Resolving Overallocations

1. Once an overallocation is identified, you decide what to do about it. Microsoft Project does not stop you working normally with the software even if overallocations exist. Some possible solutions, however, are:

   a) Do nothing. If the overallocations are few or very small, they will normally balance themselves out when it comes to implementing the project.
   b) Increase the Max. Units for the overallocated resource(s).
   c) If the overallocation is caused by a resource assigned to too many simultaneous tasks, replace the resource on some of the tasks with underallocated ones.
   d) Change the dependencies of the tasks causing the overallocation so that they don’t conflict. This will invariably delay the project but that is a price you may have to pay for ensuring that the work is carried out effectively and in a quality manner.
   e) Use Microsoft Project’s “Leveling” feature. (see below).

Leveling a Project

You can use the Project’s leveling feature to “flatten out” resource overallocations. Leveling re-schedules tasks by adding delay and/or by splitting them until the resources assigned to them are no longer overloaded.

Because leveling invariably delays tasks, it can extend the project’s finish date. When leveling, Project does not change who is assigned to tasks and only work resources (people and equipment) are leveled, not material resources.

To carry out simple leveling on all project tasks:

1. View the Gantt Chart.
2. Select the Resource tab.
3. Click Level All in the Level group.

To see which tasks have been delayed or split and to ascertain how the project has been affected by the leveling, use the Leveling Gantt View.

1. Select the View tab.
2. Select Other Views... in the Task Views group.
3. Select More Views in the menu.
4. Select Leveling Gantt.
5. Click Apply.

The Leveling Gantt shows two bars for each task, one grey and the other blue. The grey bars show where the tasks were scheduled before leveling. The blue bars show where the tasks have been re-scheduled to after leveling.

If the leveling has badly affected your schedule, you can remove any leveling delay by:

1. View the standard Gantt Chart.
2. Select the Resource tab.
3. Click Clear Leveling in the Level group.
4. Select the Entire Project option.
5. Click OK.

For further information and explanations about leveling, search for ‘About resource leveling’ in Microsoft Project Help.

Working with Costs

You can get Project to calculate out basic costs for the tasks and resources of your project by four methods:

- Getting it to multiply the amount of work being done by each resource by their rate of pay.
- Using a fixed, “Cost per Use” for each resource.
- Entering a “Fixed Cost” for each task to cover things such as overheads and materials.
- A combination of all the above.

Project provides a variety of views so that you can see and print out cost information.

Entering Basic Resource Cost Information

In order for Project to calculate resource costs:

1. Select the View tab.
2. Click the Resource Sheet command in the Resource Views group.
3. In the Std. Rate column, type the resource rates.
4. In the Cost/Use column (optional), enter a fixed amount that is chargeable whenever the resource works on a task. This would be used in cases where there is a one-off “call out fee” or agency charge applicable.
5. In the Accrue At column (optional), enter how the cost of the resource is incurred (this is required for cash flow analysis). Use:
   a) Start – if the full cost for the resource is incurred as soon as the resource starts work on a task (“cash up front”).
   b) Prorated – if the cost of the resource is spread on a day-by-day basis over the total duration of the tasks that the resource works on.
   c) End – if the cost of the resource is incurred as soon as the resource ends work on a task.
Viewing Cost Information

To view the calculated resource costs of the project:

1. Select the View tab.
2. Click the Resource Sheet command in the Resource Views group.
3. Click the Tables command in the Data group.
4. Select Cost from the menu.
5. Observe the second column of the table (Cost). This shows the total project cost of each resource.

To view the calculated task costs of the project:

1. Select the View tab.
2. Click the Gantt Chart command in the Task Views group.
3. Click the Tables command in the Data group.
4. Select Cost from the menu.
5. Observe the fourth column of the table (Cost). This shows the total project cost of each task.

In both of the above cases, re-apply the Entry table to view general (default) information about your tasks and resources.

To view the total costs for the entire project:

1. Select the Project tab.
2. Click the Project Information command in the Properties group.
3. Click the Statistics... button in the bottom left.
4. Observe the Cost section of the window.
5. Click Close when finished.

Entering Task Fixed Cost Information

In addition to, or as an alternative to, resource-based costs, you can enter a single cost for each task.

When starting a new project, you would normally set up a standard, project calendar. This determines the default working days and times for the majority of tasks and resources.

When you create resources for your project, Project assumes that the resources will work the same days and times as shown in the standard, project calendar. It therefore assigns a copy of this calendar to the resource.

If, however, the resource works to different days and times, the resource’s calendar needs to be edited so that Project schedules the resources’ work into the correct days and times when they are available to do it.

To edit a resource calendar:

1. View the Resource Sheet.
2. Double-click the name of the resource whose calendar you wish to edit.
3. Click the Change Working Time... button.

4. Make changes in the same manner as you would for the standard project calendar, i.e. enter non-working days, make non-working day into working days, etc.

5. Click OK.